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Understanding Worksoft Execution Suite
Understanding Worksoft Execution Suite

The Worksoft® Execution Suite consists of the following applications:
 Worksoft Management Studio™ - Registers database settings, data sources, and SAP systems that you 

intend to use with the Worksoft products.
 Certify Execution Manager™ - Schedules and manages the remote execution of Worksoft Certify® 

processes.
 Certify Impact™ - Provides you with the ability to quickly deploy changes to your SAP® systems by 

identifying and executing a minimal set of Worksoft Certify processes for impacted programs and 
transactions.

System Requirements
Before you begin to install the Certify Execution Suite, verify that your environment has the needed system 
requirements installed. For information about system requirements and planning your environment, see the 
Worksoft Help Portal.

Port Requirements

Worksoft Execution Suite requires that you use the following ports when configuring the product:

LDAP Port Requirements

If you are using LDAP for authentication, you will need to use the following ports and protocol:

Warning:
Do not install Worksoft Execution Suite on the same server as the Worksoft Certify 
API data service because of the constraint of bandwidth on the network interface 
controller (NIC card).

Component Port Number

Worksoft Application Server 80 and 443

Type of Traffic AD and AD DS Usage Protocol and Port Number

LDAP Directory, Replication, User and Computer 
Authentication, Group Policy, Trusts

TCP and UDP 389

LDAP SSL Directory, Replication, User and Computer 
Authentication, Group Policy, Trusts

TCP 363

LDAP GC Directory, Replication, User and Computer 
Authentication, Group Policy, Trusts

TCP 3268

LDAP GC SSL Directory, Replication, User and Computer 
Authentication, Group Policy, Trusts

TCP 3269
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Configuring Your Application Server
Configuring Your Application Server

One or more web application servers are required. There are window services and web applications that will be 
installed for each of the products in the Worksoft Execution Suite. Read Planning and Provisioning for the 
Worksoft Execution Suite in the Worksoft Help Portal to determine if additional web application servers will be 
required.
In order to transform your application server into a web server, Microsoft® Internet Information Services (IIS) 
must be installed and the Server Manager must be configured.
These procedures assume that you have not already configured your IIS. If you have already set up the Roles 
and Features, verify that the following Role Services on page 15 have been selected.
You need to first configure your server with HTTP, and then you can reconfigure the application server to use 
HTTPS.

Adding Roles and Features

The Server Manager allows you to add specific roles and features to your web server that are required for 
Worksoft products.

 To add roles and features to your web server:

1 From the Start menu, select Server Manager.
The Server Manager opens.

2 In the Navigation pane, select Dashboard.
3 In the Summary Tasks pane, select Add Roles and Features.
8 Worksoft Certify Execution Suite Installation Guide CLASSIFICATION: PUBLIC
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Adding Roles and Features
The Add Roles and Features Wizard opens.

4 Click Next.
The Select Installation Type page opens.

5 Select the Role-based or feature-based Installation option.
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Adding Roles and Features
6 Click Next.
The Select Destination Server page opens.

7 Select a server.
8 Click Next.
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Adding Roles and Features
The Select Server Roles page opens.

9 From the Server Roles list, select the following roles:
• File Services
• Web Server (IIS)

10 Click Next.
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Adding Roles and Features
The Select Features page opens.

11 Select the following features:
• .NET Framework 4.8 Features and all of its child nodes
• WCF Services and all of its child nodes
• IIS Hostable Web Core and Media Foundation
12 Worksoft Certify Execution Suite Installation Guide CLASSIFICATION: PUBLIC



Adding Roles and Features
12 Verify that Message Queuing Services and Message Queuing Server are enabled.

13 Use the scroll bar to verify the Windows Process Activation Service is enabled with the following 
child nodes:
• Process Model
• Configuration APIs

14 Click Next.
Worksoft Certify Execution Suite Installation Guide 13CLASSIFICATION: PUBLIC



Configuring the Web Server Role (IIS)
Configuring the Web Server Role (IIS)

The Web Server Role (IIS) page opens if you have not already installed the web server. 
1 In the Navigation pane, click Role Services under Web Server Role (IIS).

The Select Role Services page opens.
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Configuring the Web Server Role (IIS)
2 In the Role Services list, use the scroll bar to select the following services.
If you have already set up the Roles and Features, verify that the following services have been selected.

3 Click Next.
The Confirm Installation Selections page appears.

4 Click Install to install the role services.

Node Child Nodes

Common HTTP Features Default Document

Directory Browsing

HTTP Errors

Static Content

WebDAV - Verify that this option is disabled. Worksoft’s 
RESTful Services will not work correctly if enabled.

Health and Diagnostics HTTP Logging

Request Monitor

Performance Static Content Compression

Dynamic Content Compression

Security Request Filtering

Basic Authentication

Application Development .NET Extensibility 4.8

Application Initialization

ASP

ASP.NET 4.8

CGI

ISAPI Extensions

ISAPI Filters

WebSocket Protocol

Management Tools IIS Management Console

IIS Management Scripts and Tools

Management Service
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Configuring Application/Json MIME Type Compression
Configuring Application/Json MIME Type Compression

After you have enabled Dynamic Content Compression within IIS, you need to verify HTTP Compression for 
the application/json MIME type. Worksoft uses Dynamic Content Compression to improve performance, and 
HTTP compression must be enabled for the application/json MIME type.
When the Dynamic Content Compression feature is enabled, it will overwrite any previous HTTP compression 
settings.

 To verify application/json MIME type compression:

1 Open IIS Manager.
2 In the left Navigation pane, click on your server. 
3 In the Management section, double-click the Configuration Editor.

The Configuration Editor opens.
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Configuring Application/Json MIME Type Compression
4 From the Section drop-down list, select system.webServer > httpCompression.

5 In the httpCompression section, click dynamicTypes.

6 Verify that application/json is listed in the dynamic compression mime types. If it is not listed, click 
the Add button in the Collection section to add it.
Worksoft Certify Execution Suite Installation Guide 17CLASSIFICATION: PUBLIC



Enabling IIS Services
7 After you completed your verification or addition, click the Close button
The Configuration Editor opens.

8 Click Apply to apply your changes.
9 Verify that dynamicTypes lists a count of six.
10 Close the editor.

Enabling IIS Services

You will now need to verify that several IIS services are enabled.

 To verify IIS services are enabled:

1 If the Server Manager is not open, select Administrative Tools > Server Manager from the 
Start menu.
The Server Manager opens.

2 In the Navigation pane, select IIS.
3 Scroll down to the Services section.
4 In the Services pane, verify that the following services are enabled and running:

• World Wide Web Publishing Service
• Web Management Service
• Application Host Helper Service
• Windows Process Activation Service

5 If any of these window services are not running, start the services.
To start a service, select the service from the list and click Start in the right menu. You can also start 
services by going to Administrative Tools > Services on your machine.
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Configuring HTTPS on Your Application Server
Configuring HTTPS on Your Application Server

To use HTTPS on your application server, leave the HTTP binding on default port 80. After you have 
reconfigured the application server to use HTTPS, the port now defaults to 443.
You need both ports open.
Complete the following tasks to configure HTTPS on your application server:
 Request an SSL Certificate from your IT department.
 Add the certificate to IIS.
 Add new binding to port 443.
Verify your SSL Settings on your application server.
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Chapter 2 Preparing Your SAP Systems for Certify 
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Overview
Overview

If you do not intend to use Certify Impact, you do not need to follow these instructions.
If you plan to use Certify Impact, you must have your SAP BASIS administrator assist you with preparing the 
SAP systems. In order to prepare your SAP system, you will need to do the following:
 Create a Certify system account in your SAP systems
 Install Certify Impact transports in your SAP systems
If you choose to use the SAP Business Process Change Analyzer (BPCA) analysis type, one of the systems you 
register with the Worksoft Management Studio must be your SAP system hosting SAP® Solution Manager. You 
will later supply an alias system name during registration to the Certify Execution Suite web installer.

Creating a Certify System Account in your SAP System

Certify Impact connects to SAP systems through a Remote Function Call (RFC) by using a configured user 
account. Use the SU01 transaction code and create the user account with the following information:

Setting Value

User Type SAP CPIC user for RFC communication

User Name Account user name

Name must have the same account credentials as when you register 
your SAP systems with the Worksoft Management Studio.

Password User password

Defaults Date format: “MM/DD/YYYY”

Decimal notation: 1,234,567.89

Profiles Ability to execute the following transport function modules:
• S_A.CPIC
• S_A.SCON
• S_A.SYSTEM

Type of User System
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Installing Certify Impact Transports in Your SAP System
Installing Certify Impact Transports in Your SAP System

Your SAP BASIS administrator needs to install Certify Impact transports into your SAP system. These transport 
files are located in the Worksoft Customer Portal. You need a User ID and password to access these transports. 
Select the transports that are best suited for your SAP system:
 IDES / ECC
 S4Hana
When running the SAP transports, turn off component checking because these SAP transports were created in 
a Worksoft SAP system that contains different components than your system.
22 Worksoft Certify Execution Suite Installation Guide CLASSIFICATION: PUBLIC
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Chapter 3 Installing Worksoft Application Server
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Installing Worksoft Application Server
Installing Worksoft Application Server

The Worksoft Application Server installs the Worksoft Management Studio. The Management Studio tool 
registers database settings, data sources, and SAP systems that you intend to use with the Worksoft products.
The domain user name is required for installation. The domain user must be an administrator of the machine 
in order to install the Worksoft Application Server.

 To install the Worksoft Application Server:

1 In your software distribution folder, right-click the WorksoftApplicationServer.exe file and select 
Run as administrator.
The Worksoft Application Server Wizard opens.

2 Click Next to begin the installation process.
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Installing Worksoft Application Server
After your system has been analyzed, the Destination page appears.

3 If you want to accept the default directory for your installation files, click Next.
If you do not want to accept the default directory for the installation files, click the Change button to 
select a different installation directory for the Certify client, and then click Next.
The Worksoft Application Server page appears.
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Installing Worksoft Application Server
4 If you want to accept Default Web Site as your website, click Next.
If you have other websites configured in the IIS, select the server from the drop-down list and click 
Next.
The Starting Installation page appears.

5 Click Next.
Then the installation completes, the Completed Installation page appears.

6 Click Finish.
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Disabling Interactive Service Detection Service

You need to disable the Interactive Service Detection service on your application server because it interferes 
with RDP functionality.

 To disable Interactive Service Detection service:

1 On your application server, open the Services program.

2 From the Services list, right-click on Interactive Service Detection and select Properties.
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The Properties dialog box opens.

3 From the Startup type drop-down list, select Disabled.
4 Verify that the Service status is marked Stopped.
5 Click OK.
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Overview
Overview

On your web server where IIS is installed, you will need to configure your system in the Worksoft Management 
Studio. The Worksoft Application Server installed the Worksoft Management Studio.
Within the Worksoft Management Studio, you will need to do the following Management Studio configuration 
tasks:

 Create a Worksoft Management Studio database

 Register all Worksoft Certify databases

 Create and register a Worksoft Execution Manager database
 Create and register a Certify Impact database
 Configure Certify Impact

 Specify product users

 Configure services

The Management Studio database maintains configuration information used by Worksoft applications and 
services. Certify Execution Manager and Certify Impact leverage information from the Worksoft Management 
Studio.

Exploring Worksoft Management Studio

Worksoft Management Studio consists of the following navigation tabs:

Navigation Tab Description

User Administration Register users and roles for each product.

Master Configuration Create the following databases:
• Management Studio
• Execution Manager
• Impact
• Analyze
• BPP
Configure the following:
• SMTP settings
• Maintenance window text
• Tenant administration
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Exploring Worksoft Management Studio
When you open Worksoft Management Studio, you will be able to see what part of your configuration requires 
attention by visual indicators.

Listed below are the visual indicators:
1. A red X means that there is either mandatory missing information or a failure with the current 

configuration. Each tab provides diagnostic information that will explain what failed and how to resolve 
the failure.

2. An animated circle means a diagnostic test is being performed to see if the configuration is complete and 
functional. If the test is successful, the circle will disappear, and if not successful, a red X will show a 
failure.

3. An exclamation mark means that there is an optional configuration that is available. No configuration has 
been made in these tabs, and you may want to configure these options in the future.

Configuration • LDAP Configuration - Configure your LDAP authentication service.
• Execution Manager - Disable notifications for each Certify process.
• Impact - Select your analysis engine and test execution integration.
• Certify Configuration - Add your Certify databases.
• Bookmark Administration - Create a shortcut to specific Certify 

process folders, Certify processes, or Micro Focus® Application 
Lifecycle Management® (ALM) Quality Manager test sets that you are 
able to run through web API.

Integration Configure your connections with the following products:
• ALM integration
• Panaya integration
• Analyze connections
• Certify/Analyze integration
• SAP systems

Change History Display change history.

Navigation Tab Description
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Creating Your Worksoft Management Studio Database

The Management Studio database maintains configuration information used by Worksoft applications 
and services. Certify Execution Manager and Certify Impact leverage information from the Worksoft 
Management Studio.
Only one Management Studio database is needed regardless of how many Certify databases already exist.

 To create the Worksoft Management Studio database:

1 Open the Worksoft Management Studio on your web server by navigating to the following address: 
http://localhost/ManagementStudio.
The Management Studio Installation page opens.

2 Enter the Worksoft Management Studio URL address.
If you did not use the default website during installation, your URL address will be different. The 
implementation of your network landscape will need to be considered when choosing a URL address. 
Verify that the URL can be accessed by all users.
The URL address should either be a domain or a machine name for on-premise installations. If using a 
machine name, you will need to decide if a fully-qualified domain and machine name is required. Do not 
use IP addresses.
If your DNS settings require a fully-qualified machine name complete with domain, please make those 
changes accordingly.
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Creating Your Worksoft Management Studio Database
If their is a load balancer in front of one or more web servers, then the URL address should point to 
the load balancer domain. If you have any questions about your specific URL address, ask your 
IT administrator.

3 In the Management Studio Database section, enter the server name in the SQL Server field.

Note: If your SQL Server database administrator does not approve of creating or updating the 
databases from within the web application for any reason, then they are able to manually 
create databases by using database scripts that are packaged within our distribution folder. 
For more information, see Appendix B “Creating Worksoft Execution Suite Databases with 
Apply.exe.”

4 For SQL Database Authentication, type the SQL user name and password in the fields to access the 
database server.
The user name and password must have enough SQL Server permissions to create a database. After 
you created your database, you are able to use a different SQL user name and password.

5 In the Database Name field, enter the name of the Management Studio database.
Worksoft recommends using the database name ManagementStudio for easy identification.

6 Click the Test Configuration button to test your connection.
If the test fails, the reason for the database connection failure appears.
After it detects that the database does not exist, a Create button appears.

7 Click the Create button to create a new database.
If your SQL Server database administrator created the database with the Apply.exe tool or you are 
upgrading your database, then you will click the Update button.
After creating the database, your SQL Server database administrator should review the database 
settings and configuration so that it meets expectations and adheres to appropriate best practices, such 
as using an appropriate recovery model.

8 Click Continue.
After saving the Management Studio configuration, you will be prompted to log on to the Management 
Studio.

9 If you are a new user, type admin@worksoft.com in the User Name field.
If you are upgrading from v9.2 to v10, use your existing Worksoft Management Studio email address as 
your user name.

10 If you are a new user, type password in the password field.
If you are upgrading from v9.2 to v10, use the password that you created for your Worksoft 
Management Studio.
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11 Click Login.
After applying this configuration, you have successfully enabled Management Studio to be operational.
The User Administration tab opens.

12 Click the Master Configuration tab.

13 If you want to enable verbose logging, select the Enable Verbose Logging option in the Management 
Studio Options section and click Save Changes.
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Registering and Creating Certify Execution Suite Databases

Databases that should be created or registered in Worksoft Management Studio include the following:
 Execution Manager database
 Worksoft Certify databases
 Certify Impact database
If you are upgrading from v9.2 to v10, see Chapter 8 “Upgrading Worksoft Execution Suite.”

 To create a Certify Execution Manager database:

1 In the Worksoft Management Studio, click the Master Configuration tab.
2 Click the Execution Manager tab.

The Execution Manager tab opens.

3 In the SQL Server field, enter the name of your SQL server.

Note: If your SQL Server database administrator does not approve of creating or updating the 
databases from within the web application for any reason, then manually create databases by 
using database scripts that are packaged within our distribution folder. For more information, 
see Appendix B “Creating Worksoft Execution Suite Databases with Apply.exe.”
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4 In the SQL User and Password fields, enter the SQL server user name and password.
The user name and password that you use will need to have enough SQL Server permissions to create a 
database. After you created your database, you are able to use a different SQL user name and password 
for use of the product.

5 In the Database Name field, enter the name for your new database.
Worksoft recommends using the database name ExecutionManager for easy identification.

6 Click the Test Configuration button to test the connection.
7 After it detects that the database does not exist, click Create to create a new Certify Execution Manager 

database.
If your SQL Server database administrator created the database with the Apply.exe tool, then you will 
click the Update button.
After creating the database, your SQL Server database administrator should review the database 
settings and configuration so that it meets expectations and adheres to appropriate best practices, such 
as using an appropriate recovery model.

8 Scroll down the Execution Manager tab to verify that the Execution Manager services are running.

9 Click Save Changes.

Note: If you want to register additional Remote Desktop Protocol (RDP) servers, you can add servers 
in the RDP Servers section. Only a single web server is required for the Certify Execution Suite. 
For more information, see “Adding RDP Servers” on page 49.
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 To register Worksoft Certify databases:

1 In the Worksoft Management Studio, click the Configuration > Certify Configuration tab.
The Certify Databases tab opens.

2 Click the Add button on the right side of the screen.
The Add Certify Database dialog box opens.

3 In the Name field, enter a unique name for your database. This name will appear in Certify Execution 
Manager and Certify Impact as the database alias.

4 In the SQL Server field, enter the name of your SQL server.
5 In the SQL User and Password fields, enter the SQL server user name and password.
6 In the Database field, start typing in the name for your database. 

A list of Certify database names appear.
7 Select a database.

If your database does not appear in the list, the permissions for the SQL User must not be adequate, or 
the database does not exist. Consult your database administrator.

8 Click the Test Configuration button to test the connection.
If the test fails, the reason for the database connection failure appears.

9 Click Add to save your registered Certify database.
When you save your Certify database, this database appears in the Certify Databases pane.

10 If you need to add another Certify database, repeat this process.
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 To create a Certify Impact database:

If you do not intend to use Certify Impact, you do not need to create a database.
1 In the Worksoft Management Studio, click the Master Configuration tab.
2 Click the Impact tab.

The Impact tab opens.

3 In the SQL Server field, enter the name of your SQL server.

Note: If your SQL Server database administrator does not approve of creating or updating the 
databases from within the web application for any reason, then manually create databases by 
using database scripts that are packaged within our distribution folder. For more information, 
see Appendix B “Creating Worksoft Execution Suite Databases with Apply.exe.”

4 In the SQL User and Password fields, enter the SQL server user name and password.
The user name and password that you use will need to have enough SQL Server permissions to create a 
database. After the database is created, you are able to use a different SQL user name and password.

5 In the Database Name field, enter the name for your new database.
Worksoft recommends using the database name Impact for easy identification. 

6 Click the Test Configuration button to test the connection.
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7 After it detects that the database does not exist, click Create to create a new Certify Impact database.
If your SQL Server database administrator created the database with the Apply.exe tool, then you will 
click the Update button.
After creating the database, your SQL Server database administrator should review the database 
settings and configuration so that it meets expectations and adheres to appropriate best practices, such 
as using an appropriate recovery model.

8 Click Save Changes.

Registering SAP Systems

If you plan to use Certify Impact, then you must register one or more SAP systems in Worksoft Management 
Studio. If you intend to just use Execution Manager, go to “Registering Users” on page 42.
Before you register your SAP system, you must have prepared your systems. For more information, see 
Chapter 2 “Preparing Your SAP Systems for Certify Impact.”

 To register SAP systems:

1 In the Worksoft Management Studio, click the Integration > SAP Systems tab.
The SAP Systems tab opens.

2 Click the Add button on the right side of the screen.
The Add SAP System dialog box opens.

You have the option of providing your SAP information in the text fields or an SAP connection string. For 
more information about using the SAP connection string, go to page 40.
Worksoft Certify Execution Suite Installation Guide 39CLASSIFICATION: PUBLIC



Registering SAP Systems
3 In the Name field, enter the name of your SAP system.
4 In the App Server Host field, type the IP address of where your application server is being hosted.
5 Enter the system number and SAP client number in their respective fields.
6 Enter the SAP user and password in their respective fields.
7 Click Test Configuration.

The Status section shows if your configuration was successful.

8 Click Save to save your SAP system.
Your SAP system is now listed in the tab.

 To use an SAP connection string to register your SAP system:

Instead of completing all the fields, you can just use an SAP connection string to register your system.
1 In the SAP Connection String field, enter a string for your SAP system.

Example: TYPE=3; ASHOST=192.168.3.56; SYSNR=01; CLIENT=800; LANG=EN; 
USER=jdoe; PASSWD=password123;

2 Click Test Configuration.
The Status section shows if your configuration was successful.

3 Click Save to save your SAP system.
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Configuring Certify Impact

If you intend to use Certify Impact, you will need to configure the following:
 Analysis engine
 Test execution integration
You will also need to add one or more SAP systems. For more information, see Chapter 2 “Preparing Your SAP 
Systems for Certify Impact.”

 To configure Certify Impact:

1 Click the Configuration > Impact tab.
The Impact tab opens.

2 Select an Analysis Engine option:
• Worksoft Certify Impact
• SAP BPCA
If you choose to use the SAP Business Process Change Analyzer (BPCA) analysis type, one of your 
SAP systems registered with Worksoft Management Studio must be hosting SAP® Solution Manager.

3 Select a Test Execution Integration option:
• Worksoft Execution Manager
• HP Quality Center
For more information on how to integrate with Micro Focus® Application Lifecycle Management® (ALM) 
Quality Manager, see Chapter 10 “Configuring Micro Focus ALM/Quality Center Integration.”

4 Click Test Configuration to test the connection.
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Registering Users

The next step to configuring Worksoft Management Studio is to register users who will be using the Worksoft 
Execution Suite. There are two ways to register users:
 Manually create users in Worksoft Management Studio
 Import users from a Microsoft Excel® spreadsheet

 To manually create users in Worksoft Management Studio:

1 In the Worksoft Management Studio, click the User Administration tab.
2 In the User Administration tab, click Add.

The Add User dialog box opens.

3 To create an active user, verify that Active is selected.
To deactivate a user, select Inactive.

4 In the related fields, enter the following information:
• First name
• Last name
• Email
• Password
• Confirm Password
If you select LDAP authentication, you do not need to enter a password.
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5 From the Authentication drop-down list, select an authentication option:
• LDAP
• Worksoft
The LDAP option only appears if you have already configured it. For more information, see “To configure 
your LDAP authentication service:” on page 46.

6 If you want to give the user administrative rights, select the Administrator option. Administrators have 
access to all products. 
The Upload Only option is for Worksoft Analyze users.

7 Select the Execution Manager and/or Impact roles for the user.
8 From the Default Time Zone drop-down list, select your preferred time zone for Certify Execution 

Manager or keep it as the server default time.
9 Click Add.

The user name appears in the User Administration tab.

Users with a green icon are active, and users with a gray icon are inactive. 
10 Repeat this process to add more users. To edit a user, click the Edit icon next to the user.
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 To register users by importing from a Microsoft Excel spreadsheet:

1 In the Worksoft Management Studio, click the User Administration tab.
2 In the User Administration tab, click Import.

The Import User dialog box opens.

3 To download an Excel template, click Download Sample Upload File.
Use this template to create your own Excel spreadsheet.

4 Click the Choose File button and select the CSV file that you want to import.
5 After you have selected your file, click the Import button.

The users are imported into the Worksoft Management Studio and appear in the User Administration 
tab.

Exporting a List of Users

From the Users Administration tab, you can export a list of the users in a CSV file.

 To export a list of users:

1 Click Export in the Users Administration tab.
A message appears.

2 Click Open to open the file in Microsoft Excel or click Save to save the CSV file.
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Configuring Your Email Service

The Certify Execution Manager and Certify Impact sends out email notifications when Certify Execution 
Manager request or Certify Impact analysis completes execution. You will need to specify the SMTP server that 
will send out the email notifications.

 To configure your email service:

1 In the Worksoft Management Studio, click the Master Configuration tab.
The Master Configuration tab opens.

2 Scroll down to the SMTP Configuration section.

3 In the SMTP Configuration section, enter the following information:
• From Email
• SMTP Host
• SMTP Port
• SMTP User Name
• SMTP Password
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4 If you want to use a SSL certificate, select the SSL option.
5 If you are using tenant spaces and want to use the Master Configuration SMTP configuration, select the 

Offers to Tenant Spaces option.
6 Click the Test Configuration button to test your connection.

If the test fails, the reason for the failure appears.
If the settings are not valid, the Certify Execution Suite will still be functional; however, the size of your 
log file will be affected since the products will log errors for all of the failed email notifications.

Disabling Notifications

You are able to disable email notifications to reduce the number of emails.

 To disable notifications:

1 In the Worksoft Management Studio, click the Configuration tab.
2 Click the Execution Manager tab.
3 Select the Disable notifications for each Certify process option.
4 Click Save Changes.

Configuring Your LDAP Authentication Service

Worksoft Execution Suite allows you to authenticate users against your Lightweight Directory Access Protocol 
(LDAP) system. During the log on process, the user name and password combinations will be validated against 
LDAP.

 To configure your LDAP authentication service:

1 In the Worksoft Management Studio, click the Configuration tab.
The Configuration tab opens.
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2 Enter the following information:

Field Description
Host/IP Address Enter the domain name or IP address of the LDAP directory server.

Domain example: worksoft.com

LDAP Port Optional - Enter the host port.

The default port number is 389. If a value is not specified, the default 
port will be used.

For secure connections using Secure Sockets Layer (SSL), the default 
port number is 636.

Base DN Enter the Base Distinguished Name (DN) for LDAP. 

LDAP references an object by its DN. The Base DN identifies the starting 
point of a search with a sequence attributes connected by commas and 
no spaces.

Example: ou=test,ou=sales,dc=example,dc=com

If the LDAP authentication throws request time-out errors, make the 
base DN search more specific.

Example: ou=people,dc=treea,dc=foobar,DC=com instead of 
dc=treea,dc=foobar,dc=com

If you do not know the Base DN, consult your LDAP administrator or 
check your LDAP browser.

Authentication Type Select the authentication method for your LDAP server:
• Anonymous 
• Basic (Default) 
• Negotiate 
• Ntlm 
If you do not know your Authentication Type, consult your LDAP 
administrator.

User DN Enter the user who will connect to the server. This user must have read 
and execute permissions for the whole sub-tree.

If your LDAP directory server requires a domain for logging on to the 
system, include the domain for the user as well.
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3 By default, LDAP traffic is transmitted unsecured. Select the Use Secure Connection (SSL) option to 
make LDAP traffic secure.

4 In the Verify LDAP User section, specify an email address and password to validate the accuracy of the 
Base DN and filter.

5 Click Test Configuration to verify that your LDAP configuration is valid.
If the test fails, the reason for the database connection failure appears.

6 Click Save Changes.

Password Enter the password to connect to the LDAP service on the specified LDAP 
Server.

Although the LDAP default character length is 128 characters, Certify 
supports only 100 characters.

Filter The default logical expression is 
(|(uid={0}*)(sAMAccountName={0}*))

This expression specifies attributes the requested LDAP entries must 
contain. Substitute the {0} with the user name in which you plan to use 
when logging on to LDAP.

If the LDAP authentication throws request time-out errors, edit the filter 
expression to the following: 

(&(objectCategory=person)(objectClass=user)(sAMAccoun
tName={0}*)) 

Example 2:
(&(objectCategory=person)(objectClass=user)
(userPrincipalName={0}*))

Each customer may need to tailor this filter differently.

Field Description
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Adding RDP Servers

You are able to register additional Remote Desktop Protocol (RDP) servers within the Worksoft Management 
Studio. Only a single web server is required for the Certify Execution Suite.
However, if you determined that you need additional RDP servers after reviewing the system requirements at 
docs.worksoft.com, then you will need to add these additional Execution Manager web servers in Worksoft 
Management Studio.
Any additional RDP servers must have the same system requirements and configuration as your main web 
server. Also, all of the servers must have the same version of Certify Execution Manager installed. If any 
requirement is not met or a different version of Execution Manager is installed, then the RDP server will report 
failures.

 To add additional RDP servers:

1 In the Worksoft Management Studio, click the Master Configuration tab.
2 Click the Execution Manager tab.

The Execution Manager tab opens.
3 Scroll down the tab until you see the RDP Servers section.

4 Click Add.
The Add RDP Server dialog box opens.
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Modifying Maintenance Window Text
5 In the Name field, enter the name of your additional RDP server.
The name of the server must be different from the original web server.

6 Click Test Configuration.
Worksoft Management Studio inspects the server to verify the requirements, services are running, and 
the version of Certify Execution Manager. If conditions are not me, the status reports errors and failures. 
Before you can add the server, you will need to fix the errors on your server.

7 If your server passes the test, click Add to add your server.
The server is listed in the RDP Servers section.

Modifying Maintenance Window Text

An administrator is able to modify the text shown in the login dialog box for Worksoft Management Studio and 
Worksoft Execution Suite.

The text that can be modified is meant for notifying when a product will not be available due to weekly 
scheduled maintenance. However, it can be modified and used for different purposes.
If you decide not to modify the text, then no information appears in your login dialog box, as shown below.
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 To modify Maintenance window text:

1 Log on to Worksoft Management Studio.
2 In the Worksoft Management Studio, click Master Configuration tab.

The Master Configuration tab opens.

The Maintenance Window section is where you will specify your modifications.
3 In the Maintenance Window section, select Management Studio from the drop-down list.

Note: Currently, only Worksoft Management Studio and Analyze are enabled.

4 From the Language drop-down list, select a language.
5 In the Title text field, enter the window title.

Titles can have a maximum of 60 characters.
6 In the Description text field, enter a message that will appear in the window.

Descriptions can have a maximum of 90 characters.
7 Click Save Changes.
8 If you have other products in which you want to customize the login dialog box, repeat this process and 

select that product.
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Creating Bookmarks

Within the Worksoft Management Studio, you are able to save your favorite Certify folders, Certify processes, 
and ALM/Quality Manager test sets by creating a bookmark. You will be able to run tests using the Execution 
Manager RESTful API.
The Bookmark Administration tab in the Worksoft Management Studio is where you create bookmarks for 
execution. You can create bookmarks for the following:
 Certify folder
 Certify process
 ALM/Quality Manager test sets

 To create a Certify folders bookmark:

1 Log on to Worksoft Management Studio as an administrator.
2 Under Configuration, click the Bookmark Administration tab.
3 In the Bookmark Administration tab select Add > Certify Folder.

The Bookmark Certify Folders dialog box opens.
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Creating Bookmarks
4 In the Name text field, type the name for your Certify folders bookmark.
5 In the Description text field, type a description for this Certify folders bookmark.
6 From the Database drop-down list, select the Certify database that contains the project which contains 

the process folder(s) you want to bookmark.
All Certify databases that are registered in Worksoft Management Studio are listed.

7 From the Project drop-down list, select the project that contains the process folder(s) you want to 
bookmark.
Folders within the project are shown.

8 Select the Certify process folders that you want to include in your bookmark.
9 Click Add.

The bookmark is added to the Bookmark Administration tab.

You will notice that the Certify folders bookmark that you created has a Folder icon next to it.
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 To create a Certify processes bookmark:

1 Log on to Worksoft Management Studio as an administrator.
2 Under Configuration, click the Bookmark Administration tab.
3 In the Bookmark Administration tab select Add > Certify Process.

The Bookmark Certify Processes dialog box opens.
4 In the Name text field, type the name of your Certify processes bookmark.
5 In the Description text field, type a description for this Certify processes bookmark.
6 From the Database drop-down list, select the Certify database that contains the project which contains 

the processes you want to bookmark.
All Certify databases that are registered in Worksoft Management Studio are listed.

7 From the Project drop-down list, select the project that contains the processes you want to bookmark.
Folders and processes within the project are shown.
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8 Select the Certify processes that you want to include in your bookmark.
9 Click Add.

The bookmark is added to the Bookmark Administration tab.

You will notice that the Certify processes bookmark that you created has a Process icon next to it.

 To create an ALM/Quality Manager test sets bookmark:

1 Log on to Worksoft Management Studio as an administrator.
2 Under Configuration, click the Bookmark Administration tab.
3 In the Bookmark Administration tab select Add > HP ALM.

The Bookmark ALM Test Sets dialog box opens.
4 In the Name text field, type the name of your ALM test sets bookmark.
5 In the Description text field, type a description for this ALM test sets bookmark.
6 From the ALM drop-down list, select the ALM instance that contains the test sets you want to bookmark.

All ALM instances that you registered in Worksoft Management Studio are listed.
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Test Lab folders with their test sets appear,

7 Select the test sets that you want to include in your bookmark.
8 Click Add.

The bookmark is added to the Bookmark Administration tab.

You will notice that the ALM test sets bookmark that you created has a Test Sets icon next to it.

 To edit or delete a bookmark:

1 If you need to edit or delete a bookmark, click the Edit button next to the bookmark in the Book 
Administration tab.
The Bookmark dialog box appear.

2 If you want to edit the bookmark, apply your edits and click Save Changes.
3 If you want to delete the bookmark, click Delete.

Executing a Bookmark

After you have created a bookmark, you will be able to execute it through the REST API calls with just the 
bookmark name or bookmark ID. Certify Execution Manager supports REST API calls from various 
development operating tools, such as Jenkins, to execute requests. For help and examples, see
http://<ServerName>/ExecutionManager/apidocs/

If you want to use this specification directly, the Swagger UI has a link that leads to the consumable Worksoft 
Execution Manager API Swagger Specification.
For more information on how to execute a bookmark, see the Worksoft Help Portal at docs.worksoft.com.
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Overview
Overview

Tenant Administration Option is for large companies who want to add multi-tenant support. Each tenant has 
isolated data for each of the products, and it is able to leverage the SMTP settings or configure a specific one.
When Worksoft Management Studio is installed, a single primary tenant is created by default, and this tenant 
is responsible for configuring the master configuration. From the primary tenant space, an administrator can 
create other tenant spaces if they want to partition data within their organization.
The administrator manages all tenants within Management Studio and assigns users to each tenant. These 
users will be managed by administrators in that tenant space.

Adding Tenants

Administrators add tenants in the Tenant Administration tab within the Worksoft Management Studio.

 To add tenants:

1 Log on to Worksoft Management Studio as an administrator.
2 Under Master Configuration, click the Tenant Administration tab.

The Tenant Administration tab opens.
3 Click Add to create a new tenant.

The Add Tenant dialog box opens.
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4 To create an active tenant, verify that Active is selected.
5 In the related fields, enter the following information:

• Tenant Name
• Email
• First Name
• Last Name
• Website
• Phone
The user that you specify will be the main administrator for this new tenant space. The default password 
for the administrator is password.

6 If you want to limit the number of users, deselect the No user limit option and enter the number of 
users.
If you do not want to limit the number of users, leave this option selected.

7 From the Default Time Zone drop-down list, select your preferred time zone for Certify Execution 
Manager.
The time zone that you selected becomes the default time zone for this tenant and all users added to 
this tenant.

8 Click Add.
The new tenant appears in the Tenant Administration tab.

9 Log out of Worksoft Management Studio by clicking the arrow in the right-hand corner and selecting 
Logout.

10 Log on to Worksoft Management Studio with the email address you specified when creating the tenant 
and the default password.
You will now be able to perform administration tasks for the newly created tenant.

11 Repeat this process for creating additional tenants.
When creating additional tenants, an email account can be associated with more than one tenant space.

Switching Between Tenants

To switch between tenants, the administrator must log out of the Worksoft Management Studio. When logging 
on to Management Studio, the administrator must select a tenant from the Tenant list.
As long as the passwords for the tenant administrators are the same, then they will be able to select tenants 
from the Tenant list. If the password for either administrator is changed, then the user will not see the Tenant 
list and will only be able to manage the tenant in which it was created.
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Adding Users to Tenants

You will now add users to your multiple tenants by one of the following methods:
 Manually add users in Worksoft Management Studio
 Import users from a Microsoft Excel® spreadsheet

 To manually add users to tenants:

1 Log on to Worksoft Management Studio as the tenant administrator.
2 From the Tenant list, select the tenant in which you would like to create a new Execution Manager or 

Certify Impact user.
3 In the Worksoft Management Studio, click the User Administration tab.
4 In the User Administration tab, click Add.

The Add User dialog box opens.

5 To create an active user, verify that Active is selected.
To deactivate a user, select Inactive.
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6 In the related fields, enter the following information:
• First Name
• Last Name
• Email
• Password
• Confirm Password

7 From the Authentication drop-down list, use the default authentication option Worksoft.
If you have configured LDAP authentication, select the LDAP option.

8 If you want to give the user administrative rights, select the Administrator option.
9 If you want the user to only be able to upload Worksoft Capture files, select Upload Only.
10 Select Execution Manager and/or Impact under User Roles.
11 If you need to change the default time zone specified by the tenant, select a time zone from the Default 

Time Zone drop-down list of this user. This time zone is used for Certify Execution Manager.
12 Click Add.

The user appears in the left User Administration tab.

13 Repeat this process to add more users.

To edit a user, click the Edit icon next to the user.
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 To add users by importing from a Microsoft Excel spreadsheet:

1 In the Worksoft Management Studio, click the User Administration tab.
2 In the User Administration tab, click Import.

The Import User dialog box opens.

3 To download an Excel template, click Download Sample Upload File.
Use this template to create your own Excel spreadsheet.

4 Click the Choose File button and select the CSV file that you want to import.
5 After you have selected your file, click the Import button.

The users are imported into the Worksoft Management Studio and appear in the Users Administration 
tab.
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Installing Remote Certify Execution Manager Agents

In order to use the Worksoft Certify Execution Manager, you will need to install a Certify Execution Manager 
Agent on each dedicated machine allocated for remote execution. The Certify Execution Suite Server 
communicates with the Agents and sends requests to start executing processes and projects.
You are able to install Certify Execution Manager Agents two different ways:
 From the software distribution folder
 From Certify Execution Manager

Note: If the Certify Execution Manager Agent is not installed on the default C: drive, then you will 
need to create an AGENT_LOCATION parameter when you configure a resource in Execution 
Manager. 

Also, if Worksoft Certify is not installed on the default C: drive, then you will need to create a 
CERTIFY_LOCATION parameter when you configure a resource.

 To install a Certify Execution Manager Agent from the software distribution folder:

1 In your software distribution folder, double-click the Remote Execution Agent.exe file.
The Certify Execution Manager Agent installer opens.

2 Click Next.
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When the system analysis has completed, the Destination Folder page appears.

3 If you want to accept the default directory for your installation files, click Next.
If you do not want to accept the default directory for the installation files, click the Change button to 
select a different installation directory for the Certify client, and then click Next.
If the directory is different, you will also need to update the directory in the Execution Manager 
Resources page.
The Registration Details page appears.

4 In the Execution Manager URL text field, enter the URL address for your Execution Manager.
5 In the Email and Password fields, enter your credentials to log on to Execution Manager.
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6 If you have a tenant, enter the name in the Tenant Name field.
7 If you want to register your machine as a resource, select the Register with EM option.
8 Click Next.

The Completing the Installation page appears.

9 Click Next.
The Completing Last Steps page appears.
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10 Click Finish.
Certify Execution Manager Agent installation is complete. Repeat this installation process for all of the 
client machines that you intend to use with the Execution Manager Server.
The Certify Execution Manager Agent must be running in order for the Execution Manager Server to 
connect with the machine that will be executing Certify processes. When you start Certify Execution 
Manager, the agent will automatically start. When you log off, the Agent shuts down.

AutoDispose Parameter

When you register the agent as an Execution Manager resource during installation by selecting the Register 
with EM option, an AutoDispose parameter is added to the resource. This parameter warns the user that after 
the self-registered resource has been idle after a period of time, it will be deleted. The default time is six hours. 

This parameter’s value can be changed in the ProductSettings database table in Worksoft Management Studio 
by changing the parameter value to False or deleting the parameter.

Installing the Agent from Execution Manager

You can also install an Agent from Execution Manager.

 To install a Certify Execution Manager Agent from the Execution Manager:

1 From Certify Execution Manager, click the Resources tab.
2 In the right pane, click Download E/M Agent.

A message appears asking if you want to open or save the ExecutionManagerAgent.zip file.
3 Click Open, Save, or Save As.
4 If you clicked Save or Save As, unzip the ExecutionManagerAgent.zip file.
5 Right-click Execution Manager Agent.exe.

The Certify Execution Manager Agent installer opens.
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Configuring Resource Client Machines

The resource machine where Certify Execution Manager Agent is installed needs to be able to respond to pings 
from the web server when you utilize Remote Desktop Protocol (RDP). You will need to complete the following 
settings in order for your machines to successfully execute requests:
 Configure resource machines to be responsive to Execution Manager pings
 Disable Windows Fast User Switching mode

Configuring Resource Machine to be Responsive to Execution Manager Pings

In order for you to be able to ping your resource machine in the Certify Execution Manager Resources screen, 
you will need to enable the following inbound rules:
 File and Printer Sharing (Echo Request - ICMPv4-In)
 File and Printer Sharing (Echo Request - ICMPv6-In)

 To configure your resource machine to be responsive to pings:

1 Open Windows Firewall with Advanced Settings tool on your machine.
2 In the left Navigation pane, click Inbound Rules.
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3 Verify that the following inbound rules are enabled:
• File and Printer Sharing (Echo Request - ICMPv4-In)
• File and Printer Sharing (Echo Request - ICMPv6-In)

4 If any of these rules are not enabled, right-click on the No next to the rule in the Enabled column and 
select Enable Rule.

5 After you have enabled all of these rules, close the Windows Firewall with Advanced Settings tool.

Note: If you have a Citrix environment, the Citrix server must be configured to support RDP 
sessions. Test your configuration by running mstsc.exe. This configuration setting is not 
enabled by default.

Disabling Windows Fast User Switching Mode

Execution Manager Agents require the ability to enter a user name and password on the screen. If the login 
screen displays a Switch User button, then the Agent will not start. Consult your IT administrator about 
disabling the Fast User Switch mode in the Local Group Policy Editor.

 To disable Windows Fast User Switch mode:

1 From the Windows Start menu, type gpedit.msc, and press Enter.
The Local Group Policy Editor opens.

2 In the Local Group Policy Editor Navigation pane, drill down and select Computer Configuration > 
Administrative Templates > System > Logon. 

3 In the Setting pane, double-click Hide entry points for Fast User Switching.
The Properties dialog box for this setting opens.

4 Select the Enabled option.
5 Click OK.
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Accessing the Certify Execution Manager Agent

On the client machine, select Start > Programs > Worksoft Execution Manager Agent > Worksoft 
Execution Manager Agent.
The Execution Agent opens.

When you start the Execution Agent, you will see a list of diagnostic tests that have been performed on your 
machine. Each test displays one of the following status icons:

The last run diagnostics status also displays below the grid.
Each time the Execution Manager starts, it automatically performs the analysis and reports these findings. If 
you make adjustments to the configuration and policy, click Run Diagnostics to run the tests again and to 
see if all the tests passed.

Icon Description

Test passed.

Mandatory configuration was not met and 
must be fixed. You will not be able to 
execute requests.

Warning that there is a failure, but requests 
still might be able to run.
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Best Practices for Using RDP with Multiple Local Users

If you have multiple local users running tests using RDP, you will need to configure your machine to avoid 
initial log on time consumption and requests failing to execute.

Avoiding Initial Log on Time Consumption

After creating a local user on a machine, manually log on as the new user because the initial log on to 
Windows is sometimes time consuming.

Avoiding Requests Failure

Even if the local user running tests belongs to the Administrator group on the machine, you will still need to 
turn off the User Account Control notifications. If you do not turn them off, the requests fail to execute.
Open the User Account Control Settings window and select Never Notify to prevent any unexpected 
notifications that might get in the way of the Execution Manager Agent.
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Troubleshooting RDP Sessions

If any of the following conditions occur, then it will result in black screen captures and the automation will fail:
 Minimizing an RDP session
 RDP session disconnected

Examples: User clicks Close button, maximum CPU utilization, network NIC card maximized, VPN turned 
off, or any network communication issues

 Machine gets locked
Examples: Screen saver locks it or user or domain policy locks the machine

 Execution Manager Agent does not start automatically. For more information, see Appendix C “Creating a 
Task in the Windows Task Scheduler.”
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Upgrading Worksoft Execution Suite v9.2 to v10

1 Uninstall Worksoft Execution Suite v9.2.
2 After you uninstall the Execution Suite, delete the Worksoft Application Server folder in the 

following default location: 
C:\Program Files (x86)\Worksoft

3 Install the Worksoft Application Server v10. For information on how to install the server, see Chapter 3 
“Installing Worksoft Application Server”

4 Open the Worksoft Management Studio on a local machine by navigating to the following address: 
http://localhost/ManagementStudio.
The Management Studio Installation page opens.

5 Enter the Worksoft Management Studio URL address.
If you did not use the default website during installation, your URL address will be different. The 
implementation of your network landscape will need to be considered when choosing a URL address. 
Verify that the URL can be accessed by all users.
The URL address should either be a domain or a machine name for on-premise installations. If using a 
machine name, you will need to decide if a fully-qualified domain and machine name is required. Do not 
use IP addresses.
If your DNS settings require a fully-qualified machine name complete with domain, please make those 
changes accordingly.
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If their is a load balancer in front of one or more web servers, then the URL address should point to the 
load balancer domain. If you have any questions about your specific URL address, please ask your IT 
administrator.
If you intend to use HTTPS for your application server, you will need to first configure your server with 
HTTP, and then you will be able to reconfigure the application server to use HTTPS. For more 
information, see Appendix B “Creating Worksoft Execution Suite Databases with Apply.exe.”.

6 If you want to enable verbose logging, select the Enable Verbose Logging option.
7 To view the status of your services, click the Services down arrow.
8 In the Management Studio Database section, enter the server name in the SQL Server field.
9 For SQL Database Authentication, type the SQL user name and password in the fields to access the 

database server.
The SQL Server user account must have necessary permissions to create or update the database. If 
needed, you are able to use a temporary SQL Server administrator with permissions, and then update 
the SQL Server user credentials for only this database.

10 In the Database Name field, enter the name of the Management Studio database.
11 Click the Update button.

A message appears asking if you want to update the Worksoft Management Studio database.
12 Click Update.
13 Click Continue.

After saving the Management Studio configuration, you will be prompted to log on to the Management 
Studio.

14 In the User Name field, use your existing Worksoft Management Studio email address as your user 
name.

15 In the Password field, use the password that you created for Worksoft Management Studio.
16 Click Login.
17 In the Worksoft Management Studio, click the Master Configuration tab.
18 Click the Execution Manager tab.

The Execution Manager tab opens.
19 Click the Update button to update the database.

A message appears asking if you want to update the Certify Execution Manager database.
20 Click Update.
21 Click the Impact tab.

The Impact tab opens.
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22 Click the Update button to update the database.
A message appears asking if you want to update the Certify Impact database.

23 Click Update.

Note: If you have more than one Certify Execution Manager and Certify Impact databases, you are 
able to easily update the database. Start typing the name of the database in the field, and a 
list of database names appear. If your database does not appear in the list, the permissions 
for the SQL User must not be adequate. Consult your database administrator.

Upgrading Databases for Multi-Tenancy

To finish the upgrade process, open the Microsoft SQL Management Studio to configure databases for 
multi-tenancy. Because of the major architecture updates, there is an extra manual step that is required by 
your Microsoft SQL Server database administrator. You will need to have permissions and access to manually 
run two database scripts.

 To upgrade Certify Execution Manager database for multi-tenancy:

1 Open the Microsoft SQL Management Studio.
2 Open the Databases folder for ExecutionServer.
3 Open the Populate-tenant.sql file in the Microsoft SQL Management Studio.
4 In the Use line, add the Execution Manager database name that needs to be upgraded for 

multi-tenancy.

This line verifies that the Execution Manager database is the focus, and it will be the actual database 
updated during this operation. Use the full name of the Execution Manager database.

5 In the Declare line, add your Execution Manager database and the SQL Management Studio database 
that you will need sync with for the multi-tenancy.

This line verifies that this TSQL script knows the name of the Management Studio database, and it will 
be querying information required from the Management Studio database to perform the update on the 
Execution Manager database. Use the full name of the Management Studio database within the single 
quotes at the end of this line, as shown in red.

6 Run the SQL query.
7 Verify that you get a success message after the query has completed.
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 To upgrade Certify Impact database for multi-tenancy:

1 Open the Microsoft SQL Management Studio.
2 Open the Databases folder for Impact.
3 Open the Populate-tenant.sql file in the Microsoft SQL Management Studio.
4 In the Use line, add the Certify Impact database name that needs to be upgraded for multi-tenancy.

This line verifies that the Certify Impact database is the focus, and it will be the actual database updated 
during this operation. Use the full name of the Certify Impact database.

5 In the Declare line, add your Certify Impact database and the SQL Management Studio database that 
you will need sync with for the multi-tenancy.
This line verifies that this TSQL script knows the name of the Management Studio database, and it will 
be querying information required from the Management Studio database to perform the update on the 
Certify Impact database. Use the full name of the Management Studio database within the single quotes 
at the end of this line.

6 Run the SQL query.
7 Verify that you get a success message after the query has completed.

Updating Resources

Certify Execution Manager v10 provides the ability for concurrent Remote Desktop Protocol (RDP) user 
sessions on remote machines for continuous testing in parallel and helps remove several constraints and 
limitations.
With this version, you will need to add users to your resources. Resource machines need to be powered on, 
but they no longer need to have the Execution Manager Agent running. Execution Manager starts the Agent 
before execution. You will need to edit each resource and configure user credentials in order for processes to 
execute properly.
In this release, Certify Execution Manager will automatically:
 Identify an available machine and an available user account.
 Reserve the machine and user account for the duration of executing a Certify process.
 Log on to the reserved machine using the user account to automatically start the Execution Manager 

Agent.
 Start Certify to execute the process and results are saved in the Certify database.
 Close Certify and Execution Manager Agent when the execution of the Certify process is complete.
 Log out of the machine.
The machine and user account will then be available for subsequent executions of other Certify processes.
For information on how to configure and register your resources, see the topic Upgrade to Certify Execution 
Manager v10 in the Worksoft Help Portal.

Note: If you are upgrading from v9.2 to v10, you will need to provide additional settings for your 
LDAP Connection. For more information, see “To configure your LDAP authentication service:” 
on page 46.
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Upgrading Worksoft Execution Suite v10.0.0 to v10.0.X

Before upgrading Worksoft Execution Suite, verify that you have installed Media Foundation when you 
configured your application server. For more information, see page 12.

 To upgrade Worksoft Execution Suite v10 to v10.0.1:

1 From the distribution package, run the installer.
The application will install on top of the previous version.

2 In the Worksoft Management Studio, verify that all of your configurations are set correctly.
Any configuration problems will be highlighted in the color red. After you have reset your configurations, 
you are ready to start using the applications.

3 Each time you perform an upgrade, you will need to update the following databases:
• Management Studio
• Execution Manager
• Certify Impact
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Accessing Certify Impact

The URL address for Certify Impact is http://<servername>/Impact/

Accessing Certify Execution Manager

The URL address for Certify Execution Manager is http://<servername>/ExecutionManager/

REST API Support for Execution Manager

Certify Execution Manager supports REST API calls from various development operating tools, such as Jenkins, 
to execute requests. For help and examples, see 
http://<ServerName>/ExecutionManager/apidocs/

If you want to use this specification directly, the Swagger UI has a link that leads to the consumable Worksoft 
Execution Manager API Swagger Spec.
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Overview
Overview

You are able to integrate with Micro Focus® Application Lifecycle Management® (ALM) Quality Manager and 
leverage your test sets from Certify Execution Manager. The Certify Execution Manager runs ALM/Quality 
Center test sets in parallel which reduces the time needed for regression testing. The results are stored directly 
into ALM/Quality Center, and a consistent audit log is provided. 
In order to run ALM/Quality Center test sets from Certify Execution Manager, the web server hosting Worksoft 
Execution Suite and each resource machine must have the following:
 ALM/Quality Center Client installed
 ALM/Quality Center Connectivity tools installed
 ALM/Quality Center Client registered
For information on how to install the ALM/Quality Center Client and register it, go to the Micro Focus ALM site.

Installing the ALM/Quality Center Connectivity Add-On Tool

To connect ALM/Quality Center with the Worksoft Execution Suite, you need to install the ALM/Quality Center 
Connectivity Add-On tool on the web server hosting Worksoft Execution Suite and each resource machine.

 To install the ALM/Quality Center connectivity add-on tool:

1 Open the Micro Focus Application Lifecycle Management (ALM) site.
2 Click Tools.
3 On the Tools screen, click HP ALM Connectivity.
4 Click Download HP ALM Connectivity.
5 On the ALM Connectivity screen, click Save and save the TDConnect.exe file.
6 Browse to where you saved the file, and right-click on TDConnect.exe and select 

Run as administrator.
After the installation completes, a message appears.

7 Click OK.
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Integrating Worksoft Execution Suite with ALM/Quality Center

If you plan to integrate with ALM/Quality Center, you will need to validate your connection with Worksoft 
Management Studio.

 To validate ALM/Quality Center with Worksoft Execution Suite:

1 In the Worksoft Management Studio, click the Integration tab.
2 Click the ALM Integration tab.

The ALM Integration tab opens.
3 Click Add. 

The Add ALM Configuration dialog box opens.
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4 Enter the following information:

5 Click Test Configuration.
Information about the connection appears in the Status section.

Integrating with Certify Impact

To integrate with Certify Impact, select ALM/Quality Center as the Test Execution Integration option in the 
Configuration tab. For more information, see “Configuring Certify Impact” on page 41.

Field Description

Name Name for your ALM/Quality Center connection

Instance URL ALM/Quality Center URL address

Domain ALM/Quality Center domain

Project ALM/Quality Center project

User ALM/Quality Center user name

Password ALM/Quality Center password
Worksoft Certify Execution Suite Installation Guide 85CLASSIFICATION: PUBLIC



Chapter 11 Configuring Panaya TDx Integration

In This Chapter

Overview ............................................................................................................................ 87
Configuring Certify BPP ........................................................................................................ 87
Adding Panaya TDx Information to Worksoft Management Studio ........................................... 88
Creating Bookmarks for Panaya TDx Integration .................................................................... 90
Creating a Worksoft Automation Cycle .................................................................................. 90
Worksoft Certify Execution Suite Installation Guide 86CLASSIFICATION: PUBLIC



Overview
Overview

Worksoft supports the integration with the Panaya Test Dynamix (TDx) Platform. The common workflow for 
TDx is the reporting of test results based on build numbers. Worksoft Certify results can contain an application 
and build number to correlate results with reporting on changes in the build.
In order to enable this integration with TDx, you will need to complete the following:
 Enable Panaya TDx for API integration.
 Configure Certify Business Process Procedure (Certify BPP) in Worksoft Management Studio. Certify BPP is 

used to create comprehensive reports for test results.
 Add Panaya TDx information to Worksoft Management Studio for integration.
 Create bookmarks in Worksoft Management Studio for Certify processes that you want to make available in 

Panaya TDx.

Configuring Certify BPP

After you have enabled Panaya TDx for API integration, you will open Worksoft Management Studio to 
complete the configuration. The first step is to configure Certify BPP. Certify BPP is a web-based reporting tool 
that automatically generates comprehensive reports for development, quality assurance, training, and 
compliance. 
For more information about Certify BPP, see the Worksoft Help Portal.
Certify BPP has Certify databases specified in its configuration file. Each Certify database in Certify BPP has an 
alias name, and each Certify database in Worksoft Management Studio has an alias name. You must verify that 
the Certify databases in the Certify BPP configuration file match the database names in Worksoft Management 
Studio.
If there are differences in the database names, Worksoft recommends that you change the names within the 
Certify BPP configuration file.

 To configure Certify BPP:

1 Open Worksoft Management Studio.
2 In the Worksoft Management Studio, click the Master Configuration tab.
3 Click the BPP tab.
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The BPP tab opens.

4 In the Instance URL text field, enter the URL address for your Certify BPP instance.
Examples: http://machinename or https://machinename

5 Click Test Configuration.

Adding Panaya TDx Information to Worksoft Management Studio

The next step is to add Panaya TDx information to Worksoft Management Studio so that the Worksoft 
Integration Gateway can point to the instance.

 To add Panaya TDx information:

1 In the Worksoft Management Studio, click the Integration tab.
2 Click the Panaya Integration tab.
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The Panaya Integration tab opens.

3 In the Service URL field, enter the URL address for your Panaya instance.
4 In the System UID field, enter the unique identification number for Panaya.

To find the UID in Panaya, open the Settings panel and select Configuration. In the Automatic Testing 
Tool section, click on Copy UID To Clipboard.

5 In the User and Password fields, enter your Panaya credentials in the respective fields.
6 In the Polling Interval field, enter the number of seconds Execution Manager will query for new tasks in 

Panaya TDx. 
The recommended value from Panaya is 60 seconds or greater.

7 In the BPP Report Template drop-down list, select the template that you want to use for your report.
You must have Certify BPP configured in order to see the templates list.
You can select multiple templates by pressing the <Ctrl> key while selecting several templates or by 
pressing the <Shift> key when selecting a consecutive range of templates. If more than one template 
is specified, one report is generated for each template. For example, if you selected three report 
templates, each process will generate three reports.

8 In the Certify Results Folder field, enter the name of the folder in which your results will be saved.
9 Click Test Configuration.

A message appears if the connection was successful.
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Creating Bookmarks for Panaya TDx Integration
Creating Bookmarks for Panaya TDx Integration

The next step is to create bookmarks in Worksoft Management Studio that will point to the Certify processes 
that you want to make available in Panaya TDx. 
Worksoft Management Studio integrates with Panaya TDx with bookmarks. When using Panaya, a user can 
select either a single bookmark or all bookmarks. As a result, the Certify processes are added to a Panaya 
Worksoft Automation Cycle accordingly.
For information on how to create bookmarks, see Chapter Chapter 5, “Adding Bookmarks,” on page 52.
After you have completed creating bookmarks, your integration is complete.

Creating a Worksoft Automation Cycle

After you have configured the integration, create a new automation cycle in Panaya and select the 
Worksoft Automation option.

In order for Panaya to communicate with Worksoft Integration Gateway, you need to do the following:
 Select the new Worksoft cycle in the Navigation pane.
 Click the Sync Settings tab.
 In the Sync Settings tab, click New.
 From the Machine drop-down list, select the host name of Worksoft Management Studio and click Save.
 Click Sync and click the Refresh button.
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Creating a Worksoft Automation Cycle
Under the Worksoft cycle, the Worksoft project and processes appear.

Now that the Certify processes appear within Panaya, it is possible to create one or more Panaya playlists using 
one or more of these processes at any time. When you run the Panaya playlist, the Worksoft Integration 
Gateway will be instructed to begin execution. An Execution Manager request is created within Execution 
Manager automatically. The new request contains each of the Certify processes that were added to the Panaya 
playlist. 
For more information about Panaya playlists, go to Panaya’s web page.
After test execution is complete, you can view the results in Panaya TDx. The results appear in a report that 
utilizes the Certify BPP template you specified in Worksoft Management Studio.
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Appendix A Troubleshooting
Before contacting Worksoft Support, use the Worksoft Diagnostics tool that is located in the Tools folder of 
the installation package. When you run the Worksoft Diagnostics tool on your web server, this tool generates 
a diagnostic results file.

 To create a diagnostic results file with the Worksoft Diagnostics tool:

1 In the Tools folder of the installation directory, copy the worksoftdiagnostics.exe file to your 
web server.

2 Right-click on the worksoftdiagnostics.exe file and select Run as Administrator.
3 Click the Start button.

The process will take several minutes. The WorksoftDiagnostic_<machine name>.html file opens 
in the default browser on the machine.

4 Review the diagnostic results file and follow the instructions listed in the file.
5 After you have completed the tasks listed in the file, rerun the tool again if you are still having trouble 

with installation.
6 If needed, send the last results file to Worksoft Support.
If you still have trouble installing the Worksoft Execution Suite, go to the Worksoft Community site to view 
solutions to issues that you may have encountered with the installation. In order to utilize the Worksoft 
Community site, you will need to register on this site: http://portal.worksoft.com/. 

Verifying the Worksoft Management Studio Configuration File

If you are having trouble with Worksoft Management Studio’s URL address, you can verify the address in the 
configuration file.

 To verify the Worksoft Management Studio configuration file:

1 Open the Worksoft Management Studio configuration file in Notepad. Go to the following default folder 
to open the file:
C:\Program Files (x86)\Worksoft\Worksoft Application Server\
ManagementStudio\web.config

2 In the configuration file, find the setting <add key="MgmtStudioURL" value=.
3 Verify that the URL address matches the one that you entered in the Configuration tab of the 

Management Studio.
Example: https://worksoftMSServer.worksoft.com/managementstudio

4 Save the updated configuration file.

https://wscommunity.force.com/Community/s/login/


Appendix B Creating Worksoft Execution Suite 
Databases with Apply.exe

You will create and update your Worksoft Execution Suite databases in the Worksoft Management Studio. If 
your database administrator needs to create these databases, they are able to utilize the Apply.exe tools in the 
Databases folder within your Worksoft Execution Suite distribution package. This Appendix will show you how 
to update all of your databases with the Apply.exe tool.

Creating or Updating the Worksoft Management Studio Database

The Worksoft Management Studio tool registers database settings, data sources, and SAP systems that you 
intend to use for Worksoft products. The Management Studio database maintains configuration information 
used by applications and services. Only one Management Studio database is needed regardless of how many 
Certify databases already exist.

 To create a Worksoft Management Studio database:

1 Locate the Apply.exe utility within your Worksoft Execution Suite distribution package:
...\Databases\ManagementStudio

2 Double-click Apply.exe.
The Apply utility opens.
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Creating or Updating Your Execution Manager Database
3 In the Apply tool’s text fields, enter the following database connection information:
• Database server name
• Database name

4 Do not select the Windows Authentication option. Worksoft Execution Suite does not support 
Windows authentication.

5 For SQL server authentication, type the user name and password in the text fields.
6 Click Start.

The Apply utility begins to create your new database.
If the database created successfully, then a message appears.

7 Click OK.

Creating or Updating Your Execution Manager Database

You need to create your database for Execution Manager before you install the Worksoft Execution Suite. If 
you have an existing Execution Manager database, follow the instructions in this procedure to update it.

 To create an Execution Manager database:

1 Locate the Apply.exe utility within your Worksoft Execution Suite distribution package:
...\Databases\ExecutionServer

2 Double-click Apply.exe.
The Apply utility opens.

3 In the Apply tool’s text fields, enter the following database connection information:
• Database server name
• Database name
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Creating or Updating a Certify Impact Database
4 Do not select the Windows Authentication option. Worksoft Execution Suite does not support 
Windows authentication.

5 For SQL server authentication, type the user name and password in the text fields.
6 Click Start.

The Apply utility begins to create your new database.
If the database created successfully, then a message appears.

7 Click OK.

Creating or Updating a Certify Impact Database

You need to create your database for Certify Impact before you install the Certify Execution Suite. If you have 
an existing Certify Impact database, follow the instructions in this procedure to update it.

 To create a Certify Impact database:

1 Locate the Apply.exe utility within your Certify Execution Suite distribution package:
...\Databases\Impact

2 Double-click Apply.exe.
The Apply utility opens.

3 In the Apply tool’s text fields, enter the following database connection information:
• Database server name
• Database name
Worksoft Certify Execution Suite Installation Guide 95CLASSIFICATION: PUBLIC



Creating or Updating a Certify Impact Database
4 Do not select the Windows Authentication option. Worksoft Execution Suite does not support 
Windows authentication.

5 For SQL server authentication, type the user name and password in the text fields.
6 Click Start.

The Apply utility begins to create your new Certify Impact database.
If the database created successfully, then a message appears.

7 Click OK.
96 Worksoft Certify Execution Suite Installation Guide CLASSIFICATION: PUBLIC



Appendix C Creating a Task in the Windows Task 
Scheduler

The Windows Task Scheduler can be used to start an Execution Manager Agent if you notice that the Agent 
does not automatically start after the RDP session starts. In some cases, the application security configuration 
prevents starting the Execution Manager Agent application with elevated privileges. In this case the Windows 
Task Scheduler should be used to initiate the Execution Manager Agent with elevated privileges on user login.

 To create a task in Windows Task Scheduler:

1 From the Windows Start menu, open Task Scheduler.

2 In the right Actions pane, select Create Task.
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The Create Task dialog box opens.

3 In the Name field of the General tab, enter Start EM Agent.
4 In the Description field, type Start EM Agent on user login.
5 Click the Change User or Group button.

The Select User or Group dialog box opens.

6 In the Enter the Object Name field, type Users. 
7 Click Check Names.

The text field auto populates with <machine_name>\Users.
8 Click OK.
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The dialog box closes, and BUILTIN\Users appears in the User Account field.

9 In the Security Options section, select the following:
• Run only when user is logged on
• Run with highest privileges

10 Click the Triggers tab.
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The Triggers tab opens.

11 To create a new trigger, click the New button.
The New Trigger dialog box opens.
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12 In the Begin the task drop-down list, select At log on.
13 Click OK.

The new trigger appears in the Triggers tab.

14 Click the Actions tab.
The Actions tab opens.
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15 To create a new action, click the New button.
The New Action dialog box opens.

16 From the Actions drop-down list, select Start a program.
17 Click the Program/Script Browse button and point to where WorksoftExecutionAgent.exe is 

installed.
18 Click OK.

The new action appears in the Actions tab.
19 In the Conditions tab, keep all defaults.
20 Click the Settings tab.
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The Settings tab opens.

21 Verify that the following two options are NOT selected:
• Stop the task if it runs longer than:
• If the running task does not end when requested, force it to stop.

22 From the If the task is running.... drop-down list, select Run a new instance in parallel.
23 Click OK.
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Appendix D Silent Installation

Silent Install

To run Worksoft Execution Suite installation silently, run the installer from the command line and add /s option 
to the executable: 
WorksoftApplicationServer.exe /s

Installation Log File

The default installation log is located at %userprofile% of the user who installed Worksoft Execution Suite. 
To provide an alternative location for this installation file, enter the following command to override the original 
file location:
WorksoftApplicationServer.exe /s /l=C:\temp\WASiInstalllog.txt

Silent Uninstall

To uninstall Worksoft Execution Suite silently, enter the following command:
WorksoftApplicationServer.exe /s MODIFY=FALSE REMOVE=TRUE UNINSTALL=YES

Execution Manager Agent

Silent Install

If using Worksoft Execution Suite version v10.1.0 or higher, enter the following command to install the Agent 
and register the Agent with Execution Manager:
Remote Execution agent.exe /s em_url=https://EMServer email=admin@worksoft.com 
password=password tenant=tenantname register=true

Enter the following command to install the Agent and skip registration of the Agent with Execution Manager:
Remote Execution agent.exe /s em_url=https://EMServer email=admin@worksoft.com 
password=password tenant=tenantname register=false (to NOT register)

If using an earlier version, run the installer from the command line and add /s option to the executable: 
Remote Execution agent.exe /s
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Installation Log File
Installation Log File

The default installation log is located at %userprofile% of the user who installed the Agent. To provide an 
alternative location for this installation file, enter the following command to override the original file location:
Remote Execution agent /s /l=C:\temp\EMAiInstalllog.txt

Silent Uninstall

To uninstall Execution Manager Agent silently, run the installer from the command line and enter the following 
string:
Remote Execution agent.exe /s MODIFY=FALSE REMOVE=TRUE UNINSTALL=YES
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